
Jarnal
Page mark up and collaboration system

1 Syntax

java -jar jarnal

2 Getting Started

Writing tools There are four basic kinds of writing tools - the pen, the transparent and
translucent highlighters, and the bottom highlighter. Writing takes place
at the top of the screen. That is, whatever you write covers whatever was
already written. With highlighters, this probably isn’t what you had in
mind. So you can use transparent or translucent highlighters that allow
what is underneath to show through. There is also a ”bottom highlighter”
that writes at the bottom of the screen, underneath whatever was already
written. Since the bottom highlighter does cover the background, there is
also a toggle to make that transparent or translucent as well.

Tools can have ten different colors and four widths (Fine, Medium, Heavy
and Fat). You select your tool using the Tools — Pen menu - the high-
lighter style menu lets you set which type of highlighter you want to use.
There are also some buttons for changing writing instruments quickly.
After all this intense effort choosing the perfect writing instrument, you
might like to save it. You do this by choosing Tools — Pen — Set Default.
If your current writing instrument is a pen, this will set the default pen;
if your current writing instrument is a highlighter, this will set the default
highlighter. These default instruments can by Tools — Pen — Default,
or more likely by pressing the pretty multicolored button for the default
pen and default highlighter.
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The whiteout is a white fat pen. The razor and select tools enable you
to move things around; the ruler draws straight lines; the eraser erases
individual strokes. User configurable options are kept in the .jaj file, and
are restored when the file is opened. Text mode enables you to create
new text regions and change their width by clicking (and dragging). You
may select various text features; if you choose set default text from the
format menu, this chosen text characteristics will be applied to any new
text regions you create. Context menus allow rapid choice of tools and
other options. You can cut, copy and paste things. The part that is not
obvious is how this works with pages. To select a page make sure you are
not in text mode and use the select tools to select nothing. If the page is
selected the word ”Page” in the status bar will turn blue.

Paper You write on paper. On the Format menu are a splendiferous variety of
options for what type of paper you would like: what color, how many
lines, index cards, or whatever. You can also have backgrounds, which
are graphic images that appear underneath everything else. Bookmarks:
are akin to most recently used files. There is no limit on how many
bookmarks can be remembered, and they can be deleted. Servers used for
collaboration are also bookmarked.

User Info bookmarks, server bookmarks and network save options (except prompt-
ForNetSaveName and URLEncode) are considered user information. You
may choose whether or not this information should be save in the .jaj file.
The default for any new file is not to save user information.

Transparency Bottom highlighters can have three levels of transparency: opaque, translu-
cent or transparent. This is set on a per page basis; if you are annotating
background image files, you will probably want to make your highlighters
transparent so you can see the background through them. Or just use
the transparent and translucent highlighter, which draw at the top of the
screen.

Color Trapping The color trap dialog enables you turn turn on and off specific colors on
the current page; be sure to hit Redraw Page to see the changes. This is
useful if you are collaborating and assign different collaborators different
pens; you can then easily see what different people did, without seeing
them all. To assist in this, you can import a file mapping colors to names
that will then be visible in the color trap dialog. Thanks to Peter J. G.
Long for suggesting this.

Image Insertion From the Tools menu choose Insert Image, pick an image then click to
place it on the page. You can resize it in text mode by clicking and
dragging. Also clicking on an image in text mode puts in on the clipboard
where you can paste copies of it it using Tools — Paste Image.
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3 Collaboration

Collaboration between different machines is supported. Open a document on
one machine and choose Start Server from the Collaborate menu. You may
choose which port the server binds to; if you will accept any available port,
choose port 0. The port used will be displayed in the status bar. Then from
the same or another machines, open a document and choose Connect to Server
from the Collaborate menu, or choose a bookmarked server. Enter the name
or ip address of the server in the dialog box, you may include a port as in
localhost:1189. If you do not specify a port, the default port 1189 will be used.
You may connect as many clients as you like. Initially the GUI’s of all of the
collaborating windows are locked. To make changes, you must request control
of the document using the Request Control button; once you have control, you
may use the button to Release Control. Only one person at a time may have
control. Changes made on the controlling document are reflected in real time on
the collaborating documents. If the server has control of the document, client
connections are blocked until control is released; when client connections are
being requested, the Release Control button on the server turns yellow.

3.1 Limitations

• If the server has control of the document and a window running on the
same java thread as the server (for example, opened by choosing New from
the File menu) attempts to connect, Jarnal will deadlock.

• If a document is changed prior to a client connecting, the client will not
be able to handle all of the undo/redo operations available to the server
and other clients. If an undo/redo is performed that is not available to
a client, the client is automatically disconnected, and should retrieve the
modified document by reconnecting.

4 Networking

Jarnal supports retrieving files to and from webservers. Files loaded at startup
may be specified as URLs starting with http://. Jarnal will attempt to download
the requested file using http, and will save the result locally as a temporary
file and open it. Background files, metadata files, template files and .jaj files
may all be accessed using http. The use of metadata files (see the startup
documentation) is especially recommended for loading over the network, as these
are designed to be generated by the server on the fly and provide pertinent
information, such as how to send data back to the server.

Network Save Saves file to a webserver. Note that the functionality provided is equivalent
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to submitting a form - the backend capability of processing the form data
must be provided separately.

1. Choose Network Save Options from the File menu.

2. Set the server to the page that will receive the file upload in the first
box. For example http://www.dklevine.com/workshops/testup.php3

3. Set the variables that will be transmitted in the bottom box. Each
variable is entered on a separate line in the form variable name=variable value.
For example

account=george

password=monkey

infile=$$jarnal

When you choose Network Save from the File menu, this will result in
the jarnal file you are editing being uploaded under the name infile,
and additional variables named account and password being uploaded
with values set equal to george and monkey. If the server returns
information, you can view it by choosing Show Server Message from
the file menu; this information is also echoed to the console, if you
have started Jarnal from one.

4. In place of a fixed variable value such as george, you can use spe-
cial values beginning with $ to represent internal values from Jarnal.
Supported variables are

$$jarnal the contents of the jarnal file

$$snapshot a jpg file with a snapshot of the current page of the jarnal file

$$pdf a pdf file with the entire jarnal file printed according to print
options

$f the local name of the jarnal file or unsaved.jaj if the file has not
yet been saved locally; when using multipart/form-data it is this
parameter that is passed as the filename not $g

$p fully qualified pathname of the jarnal file

$n number of pages in the jarnal file

$u a unique identifer, guaranteed not to change as long as the file
remains open and is not saved under another name; can be used
so that the server can identify the same file being repeatedly
saved

$g the network save name suggested by the user

5. To perform the upload choose Network Save from the File menu;
when running as an applet you can also use the Save button.

Using Network SaveWith Java Servlets Data uploaded to the server is by default uploaded as binary multipart/form-
data, that is as MIME. Java servlets do not decode MIME, they expect
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POST data to be urlencoded. There is a network save option URLEn-
code that you can check, or provide in a metadata file, that will force
Jarnal to upload using urlencoding. The variable representing the file will
be filled with a (rather long) ascii string consisting of base64 data which
you must then decode to get the file. There is an undocumented urlde-
coder that ships with Java that you may wish to use to decode. The
Jarnal source code also contains a public source urldecoder from Robert
W. Harder in the Jtools.java file. An alternative (thanks to Walter Yuan
for this) is to get the com.oreilly.servlet package which supports multipart
decoding. You should easily be able to locate the package using google.
You can then use it to decode the default MIME uploaded by Jarnal. This
is the recommended method, since base64 encoding both adds overhead
and significantly increases the number of bytes that must be transmitted.
Here is Walter’s source code for a sample servlet showing how to use the
com.oreilly.servlet package; it accepts MIME encoded upload and echoes
them back to the user.

Sample PHP Backend Application This small application enables you to dedicate a directory in which to store
network accessible .jaj files, and create and save new ones. When called
without any parameters, it will show you a list of files in the directory,
plus the option of creating a new file. Clicking on a file will load the
file into Jarnal, and set network save parameters so that when the file is
saved by clicking on the Network Save button or choosing Network Save,
it replaces the original file, or in the case of a new file, will prompt you to
give the file a name. Reloading the original list in your browser will show
a list with the new file. Please note that this sample application provides
no security whatsoever: if you use it, anyone in the world who can access
this application can access your .jaj files.

1. Create directory accessible to your webserver to keep your .jaj files
in.

2. Put the file template.jaj, editing it if you wish, in that directory.
template.jaj will prompt for a name on network save and the save
button is set to do a network save.

3. Edit the PHP source file to point it to the appropriate directories
and files, as indicated in the source code.

4. Place the PHP source file in a directory on your webserver from which
PHP scripts can run.

5. Make sure that you have associated the mimetype application/jarnal-
meta with java -jar jarnal.jar -m
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5 Annotation and Background Files

Background image files can be loaded, either to serve as a decorative back-
ground, or for purposes of annotation.

A background image file can contain a single or multiple images. Files contain-
ing multiple images include a zip file containing single image files, multi-page tiff
files, and pdf files. Multiple background files are supported. Opening a back-
ground file has one of two effects depending on whether the current page has a
visible background or not. If the background is visible, the opened file replaces
the existing background. If the background is not visible, the opened file is
added to the existing backgrounds, the current page is assigned the first page of
the background and pages are added for the remaining pages of the background.
Backgrounds may either be repeating or non-repeating. With repeating back-
grounds, additional pages beyond the end of the background repeat the original
background. By default single image files are repeating, multi-image files are
not.

You can toggle background images on and off on a per page basis from the pa-
per menu. You may either use external background files, with the path to the
background file stored in the jarnal file, so that when the file is reopened so will
the background images (if they haven’t been moved), or you may store the back-
grounds directly in the .jaj file. If you are collaborating, and your collaborators
do not have the external file in the same location in the file system, be sure to
choose the store background in file option. You may find annotate.jaj useful as
a template for annotation. It sets the paper to plain, size fit to background and
transparency to translucent.

A key function of Jarnal is the ability to annotate pdf files. This is done using the
JPedal libraries. The libraries consist of two parts - a GPL portion - jpedalt.jar
and a proprietary version pjes.jar - that supports embedded fonts. Please be
aware that the proprietary part is not released under the GPL and is available
for non-commercial use only. For commercial use with Jarnal or for any other
commercial use, please purchase the license. I would also like to express my
gratitude to Mark Stephens for making the excellent JPedal available under the
GPL and pjes.jar freely available for non-commercial use - as well as his patience
in helping to get the JPedal libraries to work well with Jarnal.

What types of images are supported? jpg, png and gif files are always supported.
Support for fax (tiff) and pdf files are optional. Many ways of providing support
are possible. The table below gives the recommended installation instructions.

fax minimum pdf maximum pdf
windows install the jai install jpedal windows maximum pdf
unix including linux, mac install the jai install jpedal unix maximum pdf

6



6 Install the JAI

Sun provides the JAI addon with support for additional graphical formats in-
cluding multi-page tiff for faxes and ppm files used with xpdf for pdf support on
unix systems. For Linux and Windows go to http://java.sun.com/products/java-
media/jai/ and download and install JAI for your platform. For the Mac go to
http://www.apple.com/downloads/macosx/apple/java3dandjavaadvancedimagingupdate.html.
Note: there seem to be two JAI’s to install - the connection between them is
not clear to me. Make sure to install the ”JAI Image I/O API” along with the
JAI itself.

7 Install JPedal

Download jpedallib.zip. Find the directory containing your jarnal.jar file. The
files in jpedallib.zip should be placed in a subdirectory called lib. Note that
jpedallib.zip already has a subdirectory with this name, so make sure the files
don’t end up in lib/lib. With minimum support installed you will be able to
annotate pdf files, view information about the pdf file and you can print to pdf
files. You cannot work with text in pdf files.

8 Windows Maximum PDF Support

Install Jpedal. Run Jarnal and examine the about box, noting down what it
reports your home directory is; under windows it tends to be in an obscure
location. Go to that directory and edit the file jarnshell.conf with a text editor.
In the line

pdftotext=pdftotext -eol unix -layout -f %1 -l %2 %3 %4

edit it to read

pdftotext=$lib
pdftotext -eol unix -layout -f %1 -l %2 %3 %4

where $lib should be replaced with the path to the lib directory in which you
unzipped the jpedal files.

[Instructions that are superceded by the new version of Jpedal] Go to the
ghostscript site and download and install ghostscript for windows (not ghostview).
Run Jarnal and examine the about box, noting down what it reports your home
directory is; under windows it tends to be in an obscure location. In the line
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pdfrenderer=pdftoppm -f %1 -l %2 -r %4 %5 %3

edit it to read

pdfrenderer=$path_to_gsgswin32c -dNOPAUSE -dBATCH -dTextAlphaBits=4

-dFirstPage=%1 -dLastPage=%2 -sDEVICE=png16m -sOutputFile=%3 -r%4 -f %5

where $path to gs should be replaced to the path to the directory that contains
the gswin32c executable installed when you installed ghostscript.

9 Unix including Linux and Mac Maximum PDF

Support

Install Jpedal. Install the JAI. Install xpdf if it is not already installed. Xpdf
ships with most linux distributions, but may not be installed by default. For
example, in an rpm based distribution, locate the xpdf rpm and install it. If
xpdf is not shipped with your distribution, go to the xpdf website to download
and install it.

10 Handwriting Recognition

The pen, but not the highlighters support handwriting recognition. ONLY
PRINTED CHARACTERS ARE SUPPORTED, not script, cursive, or any sort
of handwriting where the letters are all connected together. You can either
recognize all handwriting on a page Tools — Recognize Page or you can turn
on the recognition engine Tools — Recognize. Recognized characters are typed
in the most recently selected text box. Jarnal comes with a small dictionary
of lower case Latin letters; you can build your own dictionaries to add to this,
or replace it. User dictionaries are called jarnal.recog and must be located in
your home directory. If you aren’t sure where this is, take a look at the Help
— About box in Jarnal.

Other Options On the Tools — Recognize Menu you can clear the recognition dictionary
(to start over), you can Undo Recognition (also available from the Context
Menu — Type — Undo Recognition) or you can enter training mode to
build your recognition dictionary. Undo recognition works a little better
than simply hitting the undo button when in recognition mode: it undoes
the last letter recognized and all the strokes that went with it, plus it
reinitializes the recognition engine properly.
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Building a Recognition Dictionary When in training mode, any stroke that is not sufficiently recognized
causes a dialog box to pop up. You type what it is you are trying to
write in this box. Note that your are not limited to single characters;
if you are ambitious you can build an entire system of shorthand, where
single small strokes write entire large sentences.

How it Works (or Doesn’t) Each stroke is normalized to a common scale (so a very large B looks the
same as a very small B). Then a whole bunch of different methods are used
to try to determine which stroke/strokes in the dictionary match whatever
you are drawing, and they are averaged together to get a score. Then a
table of probabilities of pairs of letters is applied to guess, for example,
that if the previous letter was a q, the next letter probably isn’t going
to be an x. (The mini-Jarnal does not do this guessing or spacing - see
below.) Spacing is handled by seeing how far apart you drew your letters,
and also using the table of letter pairs - it turns out, for example that in
formal writing at least, few English words end in the letter i, so if you
try to write hi, you may find the results surprising. The table of pairs is
contained in images/pairs.txt in the Jarnal.jar file - and it can be replaced
by another table. Here is a PHP script that reads a text file in the same
directory called ”sample.txt” and writes (to the screen) the corresponding
table of conditional probabilities. So use php -q analyze.php ¿pairs.txt,
to get your pairs.txt file. Feel free to replace the existing pairs.txt with
your new one. The default table was generated by downloading from
Gutenberg a subset of their most popular books meeting certain criteria,
such as having been originally written in English and being available in
ascii format, sticking them together in a large file called sample.txt and
running analyze.php. The books actually used were Ulysses, Relativity:
the Special and General Theory, The Adventures of Sherlock Holmes, and
The War of The Worlds, which should be random enough for practically
anyone.

Source Code The source is Janalyze.java. This has no dependencies on any other part
of Jarnal, so can be dropped into any other project by simply changing
the first line of the file to reflect the correct package. However, I haven’t
documented the API yet, so you’ll have to guess this by reading the code.

The mini-Jarnal if you open Jarnal from the command line with the switch -mini a mini-
Jarnal will open. The mini-Jarnal is highly customized for handwriting
recognition. It supports enough different sets of symbols that you can
actually write something and have it recognized. Recognized text is copied
to the clipboard so you can transfer it to other programs. There is also
a calculator mode that treats whatever was recognized as an arithmetic
expression and attempts to evaluate it, copying the result to the clipboard.
The philosophy of the mini-Jarnal is somewhat different than that of text
recognition in Jarnal proper, although both share the same basic engine.
In Jarnal it tries to make an educated guess at what you meant to write,
and if you print clearly, it will get it right to a surprising extent. (And
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if you are sloppy it will produced total gibberish.) The mini-Jarnal is
designed so you can write exactly what you want, and doesn’t use nearly
as much guesswork.

11 linking

In the application, but not the applet, you can set and traverse hyperlinks to
internal and external files. Any object - image, stroke or textbox can have a
link. To insert a link, choose the ”Insert Link” tool and click on the object
you want to add the link to. This brings up a dialog allowing you to set an
manipulate the link for that object. For file links, an ”internal link” causes the
target file to be saved inside the .jaj file as an ”extra” file and the link to point
to the copy saved in the .jaj file. You can also copy links to existing extra files to
the clipboard from the internal file manager. The ”Rel” button toggle file links
from relative to absolute. The ”Paste” button pastes links from the clipboard.

To use a link, click on the ”Browse” icon next to the text mode icon, then click
on the object with the link. For non-Jarnal files, the target will open in your
web-browser, by default Firefox. Jarnal files will be opened by Jarnal - in a
new window if the file is not already opened. You can link to specific pages in
Jarnal files - copy the target page to the clipboard and when you set the link
use the paste button (no other form of pasting such as ctrl-v will work). Note
that page references are to the actual page not the page of that number, so if
the location of the page moves the reference will still be correct. Copying a page
creates a new page reference, while cutting a page puts a page on the clipboard
containing the old page reference. So if you cut and paste a page, references to
the page will still point to that page. You should be able to reference pages in
Jarnal files embedded in other Jarnal files to any depth.

12 External Programs

Jarnal (the application only) supports external programs for special purposes.
These three programs are the pdfrenderer, the ps2pdf program and the web-
browser. Defaults are set for all three, but can be modified by editing the
jarnalshell.conf file created in your home directory after you first run Jarnal. If
you aren’t sure where your home directory is, check the About box in Jarnal.
The default jarnalshell.conf file is

pdfrenderer=gs -dNOPAUSE -dBATCH -dFirstPage=%1 -dLastPage=%2

-sDEVICE=png16m -sOutputFile=%3 -r%4 -f %5

ps2pdf=ps2pdf %1 %2

browser=firefox %1
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Here the %n will be replaced by the appropriate arguments when the external
program is called. Simply replace the command on the right-hand-side of the
equality with the program of your choice. The defaults assume the programs
gs, ps2pdf and firefox exist and are in your search path.

The pdfrenderer is used when Jarnal is invoked with the -g command line option
to render pdf files. The ps2pdf is used to print pdf files no longer used and the
browser is used to view non-.jaj hyperlinks. With the ghostscript renderer, you
can improve the quality of the image at the expense of speed by adding the
switch -dGraphicsAlphaBits=4

From Michael Ellerbeck for Windows here is the procedure for using ghostscript:

WriteOnPDF.cmd - macro to annotate a PDF file

java -Xmx256m -jar c:\jarnal-install\jarnal.jar -t

c:\jarnal-install\templates\annotate.jaj -g -b %1 %2 %3 %4 %5

Use this with the following option in jarnalshell.conf to use ghostscript as the
PDF renderer; note especially the quotes around %5 to deal correctly with files
that have spaces in their names

pdfrenderer=C:\gs\gs8.50\bin\gswin32c -dNOPAUSE -dBATCH -d

-dGraphicsAlphaBits=4 -dTextAlphaBits=4 -dFirstPage=%1 -dLastPage=%2

-sDEVICE=png16m -sOutputFile=%3 -r%4 -f "%5"

13 Advanced

What is the file format? Individual pages are stored as standard .svg files. The paper is stored by
name in the title of the file, but the actual lines are not stored. A series of
newlines demarcates the break between highlighter and pen. Jarnal can
read its own .svg files and produces .svg files that should be readable by
other applications. It probably cannot read .svg files produced by other
applications. Following the idea in OpenOffice, the .jaj file used by Jarnal
is a standard zip file containing the pages plus the plain text configuration
file, plus image files, plus the background, if that is being stored in the
file. The configuration file is identified by name, but the names of the
pages do not matter, only their order. You can also access the svg text by
copying individual pages to the clipboard. You may store additional files
in the .jaj file using any zip program or the internal file manager; options
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are provided also for inserting addtional files using the command line or
via metadata. These additional files will be preserved when the .jaj file
is saved. Extra files should be named jarnal.conf, p¡integer¿.svg or start
with background or image which are the names of files used by jarnal.

Configurable Toolbars This is primarily to allow customization, for example, for small screen
pda’s where the large default toolbars may take up too much screen real
estate, but other customization is possible. You should take account of
the following:

– When running as an applet, the Save button will be replaced with
Network Save.

– One of Save and Network Save tool can be installed. The first one
encountered will be installed, any others ignored.

– Only one Request Control tool can be installed. The first one en-
countered will be installed, any others ignored.

– If the Request Control tool is not installed the Collaborate Menu is
removed.

– Tools can be commented out with ”#” (actually any invalid tool
name will be ignored).

– Toolbars are stored in the document, so unless the document is used
as a template, the changes to the toolbar will effect only the document
in which you have made the changes. Generally speaking this means
you should edit toolbars only for files to be used as templates.

Toolbars are modified by using the ”files — manage internal files” dialog
box and an external text editor of your choice. From the dialog box, you
find a list of toolbars from the dropdown menu. Click on the toolbar you
want in the list, and save it to a file. Edit the file with a text editor to
get the toolbar you want. Then open the modified file in the dialog box
to replace the selected toolbar.

• Howto Use Word Documents as Backgrounds]

A new and not well tested feature of Jarnal is the ability to use openoffice
to expand the range of documents that can be used as backgrounds to
formats supported by openoffice. This includes openoffice documents and
other odf documents, as well as documents produced by Microsoft Word,
such as .doc’s.

Once installed, if you open a file as a background (from the dialog or
command line) and Jarnal can’t figure out how to read it, then it will try
to get openoffice to convert it to a pdf. If the conversion is successful, and
the file named (for example) myfile.doc, a new file called myfile.doc.pdf
will be created in the same directory, and Jarnal will open that file as the
background.
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To use this feature you must have openoffice installed; this is true by
default on most Linux systems, but regardless, it is a free download here.
The rest of the installation must be done by hand.

1. Modify your jarnalshell.conf file in your home directory by adding
the line pdfconverter=soffice. Instead of soffice you should use the
path to the openoffice executable on your system: soffice will work
on many but not all systems. Do not include any command line
switches.

NEW NEW NEW: try downloading the installer document - open it
and click on the box. If this works, you can skip the rest.

[Warning 1: the April 30 version of the installer and the script below
had a bug]

[Warning 2: There is a bug in openoffice 2.0 that prevents the macro
from working: upgrade to openoffice 2.1]

2. Run openoffice and go to tools — macros — organize macros —
openoffice.org basic. Click on organizer, then on new. Create a
new module called Convert (this should be under My Macros —
Standard). Click on the module, then on edit, and past the following
code (based on code found here)

Sub ConvertToPDF(iFile, oFile)

Dim oPropertyValue As New com.sun.star.beans.PropertyValue

iURL = ConvertToURL(iFile)

PropertyValue.Name="Hidden"

PropertyValue.Value=True

Doc = StarDesktop.loadComponentFromURL(iURL, "_blank", 0, Array(oPropertyValue,))

URL = ConvertToURL(oFile)

PropertyValue.Name = "FilterName"

PropertyValue.Value = "writer_pdf_Export"

Doc.storeToURL(oURL, Array(oPropertyValue,))

Doc.close(True)

end sub

14 FAQ

How do I move a text box? To move a text box you do not drag on the handles, you select it using
the selection tool. You change the width by dragging the upper right
handle, and the height (if it is a flowed box) by dragging on the bottom
left handle. Clicking with the mouse in text mode starts a new text box
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with upper left where you clicked. Text boxes by default extend most of
the way across the page. If you try to start a new text box to the right
of an existing one by clicking it probably won’t work, because you clicked
in an existing textbox, which selects text rather than creating a new box.
You must first change the width of your existing box to make space for
the new one, then click to get the new box.

there when I open a new document? Settings are saved in .jaj files. If you want to change the defaults for a new
document you must open the document from a ”template” file (command
option -t name of template). The macros that are used to start jarnal use
a template file called ”default.jaj” for opening a new window for taking
notes, and ”annotate.jaj” for opening a new pdf file. To change your
options choose File — Options — Edit Current Template. A window will
open enabling you to edit the template file. Make the changes you want
then save the template file.

How do I draw a straight line? Use the ruler. I want to draw a whole bunch of straight lines and I’m tired
of having to choose the ruler for each line Choose ”sticky” ruler from the
tools menu. This will keep the ruler in play until you explicitly turn it
off. Also you may be interested in the ”ctrl-a” key which repeats the last
menu command. So if you need to erase a bunch of stuff, you could choose
the eraser, then keep hitting ”ctrl-a” to get it back.

Based on David Levine’s website, www.dklevine.com/general/software/tc1000/jarnal.htm
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